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CREATING REPORTS WITH

REPORT WIZARD AND

REPORT DESIGNER

9.1 INTRODUCTION

Till now you have learned about creating Table, Query and Form

using the respective Wizard and Designer mode.  Every application

has various types of reports.  Report wizard and Report Designer are

the main tools available in Visual FoxPro for taking outputs.  These

report tools are designed to meet a range of needs and requirements

from very simple and limited to more complex and versatile.  Visual

FoxPro provides two types of report wizard: Report Wizard and One-

to-Many Report Wizard.

The Report Wizard formats a single table report.  The One-to-Many

Report Wizard is like the One-to-Many Form Wizard, which uses a

parent-child relation between two tables to create a report.

9.2 OBJECTIVES

After going through this lesson, you would be able to

l create a Report with Report Wizard

l create a Report with One-to-Many Report Wizard
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l create a Report with Report Designer

l group data in Report Designer

l add Title and Summary Bands in Report

l print Report

9.3 CREATING REPORT WITH REPORT WIZARD

Reports can be created using:

(i) Report Wizard

(ii) Report Designer

To create a report by using Report Wizard, choose New option from

File menu or directly choose New from the toolbar. The New dialog

box appears with which you are quite familiar, as you have seen

during creating Table, Query and Form using the respective Wizard.

Choose Report radio button and then click Wizard push button.

Visual FoxPro displays the Wizard Selection dialog box as shown in

figure 9.1.  There are two types of report wizard available in this

dialog box One-to-Many Report Wizard and Report Wizard. You

have to choose one of them.  Let us select the Report Wizard to

display the “Step 1 - Select Field ” page of the Report Wizard dialog

box.

Fig. 9.1: Selecting a Report Wizard
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9.3.1   Selecting the Table

The first step in the Report Wizard, like the first step in the Form

Wizard, is to select the table and the fields you want in your report.

This dialog box is similar to the one you have seen in Query and

Form wizards.  You first need to select the database, followed by the

table and then the individual fields you want to include in the report.

The Database/Tables option available with the first step of Report

Wizard dialog box, displays the current database, if one is open.

Otherwise it displays the words Free Tables.  If a database is open,

the names of the tables it contains appears in the scrollable list and

you can choose the required table.  If the database is not open, or if

you want to use a free table, click the ellipsis button (…), which

opens a dialog box that allows you to select the required table as

shown in figure 9.2.  Let us select the STUDENT.DBF table from the

open dialog box for creating a report.

9.3.2  Selecting Fields

The “Step 1-Select Fields” dialog box also includes Field picker

buttons or movement buttons, which are found between the Available

fields list and Selected fields list.  The arrow directions indicate the

way they move fields.  A single arrow moves a single field.  Double

arrow buttons move all the fields.  To move a field from the Available

fields list, first select the field you want to move by clicking or by

using the up and down arrow keys and then click the top buttons

with the right arrow.  This moves the highlighted field to the Selected

fields list.  Repeat this process to move more fields from the Available

fields list to Selected fields list as shown in the figure 9.2.

Fig. 9.2:  Step 1 - Selecting Fields for the Report Wizard
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If you want to move all the fields from Available fields list to Selected

fields list, just click the double-right arrow.  If you have selected the

wrong fields or change your mind, then you can deselect a field

from the Selected fields list. Select that field and click the left arrow.

Similarly, you can choose the double-left arrow to move all the fields

from the Selected fields list to Available fields list.  Choose Next

push button to proceed further.

Let us select Enrol, Name and Course fields from the Available fields

and move them to Selected fields list as shown in the figure 6.2.

Choose Next to move to next step of the Report Wizard.

9.3.3  Group Records

The Step 2 - Group Records of Report Wizard allows you to define

grouping of records.  You can select up to three levels of grouping as

shown in the figure 9.3.  In the three different levels of grouping of

records, you have to select the field on which the grouping is done

or select <none> if no grouping of records is required.  Choose Next

to proceed further.

Fig. 9.3: Group Records of Report Wizard
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9.3.4  Selecting Style

The Step 3 - Choose Report Style of Report Wizard allows you to

define the over all report style.  Visual FoxPro provides five standard

report styles

q Executive

q Ledger

q Presentation

q Banded

q Dff

In the upper left corner of the dialog box, you can preview an

illustration of each style as you select it, see figure 9.4.

Fig. 9.4 : selection of Style of the Report Wizard

9.3.5 Specifying Layout

The step 4 - Define Report Layout of Report Wizard allows you to

define the over all layout of the report as shown in the figure 9.5.

The first option defines the field layout.  The two options are either
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Columns or Rows.  If you have few fields which can fit across the

page horizontally, consider the Column style report because it fits

more records on a page.  However, if you have many fields in each

record to display, you may have to consider a Row style layout.

Use the Orientation buttons to identify the paper orientation, either

portrait or landscape.  The number of columns determines the

number of columns or repeated data that can appear across a page.

For example, if you use a row style field layout, the data may not

extend beyond the middle of the page.  In this case, you can consider

having two columns on the page to double the amount of information

printed on each page.

Choose Next to proceed further.

Fig. 9.5: Define Report Layout

9.3.6 Specifying Sort Order

Choosing Next option brings you to the “Step 5 - Sort Records” of

the Report Wizard.  It allows you to specify the sort order for the

records, as you do in other wizards.  You can select any field from

the Available Fields list and move it to the Selected Fields list by
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clicking the Add > key.  You can select even more that one field for

the sorting order.  However, the order in which you select these

fields determines their sort priority.  You can  change the sort priority

by moving the selected field using the double-headed buttons to

the left of the field names.  Just click a double-headed button and

drag it up or down to a new position.  If you have selected a wrong

field for the sorting order or if you want to remove any field from the

Selected Fields list to the Available Fields list, then select the field

you want to remove and then click the  <Remove> push button.

Let us select Enrol field from the Available Fields list and move it to

the Selected Fields list for specifying the sorting order as shown in

the figure 9.6.

Fig. 9.6: Sort Records of Report Wizard

You can also sort the data in ascending or descending order.  Choose

Next push button to proceed further.

9.3.7 Generating the Report

The final step of the Report Wizard, as shown in the figure 9.7,

appears when you click Next push button from the Sort Record
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Step.  Here you only need to supply the report title.  The text appears

at the top of the report.  You can have three options:

q Save report for later use

q Save report and modify it in the Report Designer

q Save and Print report

The first option lets you save the report for later use and then returns

you to whatever you were before you started the Wizard.  The second

option saves the report and immediately opens the Report Designer

with the new report allowing further customization.  The third option

saves the report and immediately prints it.

Fig. 9.7: Finish of the Report Wizard

You also have an option to wrap fields onto continuation lines, if

they do not fit the column widths defined.  You can use the Preview

push button to preview the reports before actually saving it.  Figure

9.8 shows the Preview window of the report.
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Fig. 9.8:  The print Preview Window

You can still return to the previous steps in the wizard by clicking

the Back button.  However, if you save the report any subsequent

modifications in the report must be made through the Report

Designer.  Note that  you can not re-enter the Wizard for an existing

report.  Once you are satisfied with your report, click the Finish

push button to save your report.  The Save As dialog box appears on

the screen, where you need to mention the name of your report in

the text box.  Visual FoxPro save the report file with an extension

name .frx  You can save the report as STUDENT.FRX.

9.4 CREATING A REPORT WITH ONE-TO-MANY REPORT

WIZARD

The One-to-Many Report Wizard is similar to the One-to-Many Form

Wizard.  The various steps involved in creating a One-to-Many Report

Wizard are similar to the Report Wizard that was covered in the

previous section of this lesson.  The primary difference is that it

creates reports using two or more tables.  More specifically it creates

a report to display individual parent records and all of their children.
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To create a One-to-Many Report, choose New option from File menu

or click the New tool box.  The New dialog box appears.  Select the

Form radio button and then click the Wizard push button.  Visual

FoxPro displays the Wizard Selection dialog box as shown in figure

9.9.

Fig. 9.9: Wizard Selection Box

Choose the One-to-Many Report Wizard form Wizard Selection

dialog box.  The “Step 1- Select Parent Table Fields“ dialog box

appears to select the fields from the main or parent table. It is similar

to the first step of the regular Report Wizard shown in figure 9.10.

  Fig. 9.10: Fields from Parent Table of One-to-Many Report Wizard
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As with a normal Report Wizard, you start by selecting a database or

table to use as the main or parent table.  From the Available Fields

list, select fields which are to be included on this report.

For example, click the ellipsis (… ) button to the right of Database

and Table option and use the Open dialog box to choose “STUDENT”

as the main table.  Click the double-right arrow to select all the

fields from the Available fields list to Selected Fields list, as shown

in Figure 9.10.

Please note the small, red arrow pointing to the top half of the report

in the report image area in the upper left corner.  This visually

reminds you where the main data appears in the report.

Click the Next push button to go to “Step 2: Select Child Table

Fields” as shown in figure 9.11.  The second step looks very much

similar to the first step, except that in this step prompts for the

fields from the related or child table are displayed in the Available

Fields list.  Note that the red arrow in report image has shifted down

to the lower half of the screen.  All child records appear in a browse

like control. Therefore, all fields must fit horizontally across the

report.  If you select more fields than those which can fit horizontally,

the wizard adds a horizontal scroll bar to view them.

Fig. 9.11: Fields from Child Table of On-to-Many Report Wizard
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Click again the ellipsis (….) button to the right of the Databases and

Table option and choose “RESULT” as the related or the child table,

click the double- right arrow to add all the fields from the Available

Fields list to Selected Fields list, as shown in figure 9.11.

Note that the most important fields when creating a one-to-Many

Report are the fields that define the relation between the parent

and child. In this case, ENROL appears in both STUDENT and RESULT

tables.  Choose Next push button to proceed further to the Step 3 -

Relate Tables of the One-to-Many Report Wizard.

The Wizard sets this relation between the Parent table and the Child

table in step 3 automatically when a persistent relation exists

between the two files in their database. Otherwise, you can easily

establish the relationship using the drop down field lists from both

the tables as shown in the figure 9.12. The line joining the two

Tables shows the relation formed between parent and child table.

Fig. 9.12: Relation between Parent and Child Table

Click Next push button to go to “ Step 4- Sort Records”.  Note that

the sort is only on fields in the main or the parent table. Double-

click  on Enrol as the basic sort order, as shown in figure 9.13.
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Fig. 9.13: Sort Records of One-to-Many Report Wizard

Click Next push button to go “Step 5 - Choose Report Style” dialog

box.  The fifth step defines the report layout option.  This is similar

to the normal Report Wizard.  Select Executive Style and Portrait

radio button as paper orientation as shown in the figure 9.14.

Fig. 9.14: Report Style of One-to-Many Report Wizard
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Click Next push button to go to the “Step 6- Finish” dialog box.

Fig. 9.15: The final step of One-to-Many Report Wizard

In this last step as in the case of Report Wizard, you need to give the

title of the Report. Enter “List of the Students” as the title of the

Report as shown in the figure 9.15.  Click the Preview push button

to see the reports based on the definitions provided.  Figure 6.16

shows as the preview window of the report.  Click the Close Preview

button to return to the Wizard.  If you want to make some changes

in the report, return to the specific step used in its design by clicking

Back push button and make the required change.  You can move

between the steps and the preview mode as long as you do not leave

the Report Wizard.
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Fig. 9.16  The Print Preview Window

Once you are satisfied with your report, click the Finish push button

to save your report.  The Save As dialog box appears on the screen,

where you need to mention the name of your report in the text box.

Visual FoxPro save the report file with an extension name .frx  You

can save the report as STUDENT1.FRX.  Any subsequent changes in

your report can be done only through the Report Designer.  You

cannot re-enter the Wizard for an existing report.

INTEXT QUESTIONS

1. Write True or False for the following statements

(a) You can select up to three levels of grouping of records.

(b) You can not select more than one field for the sorting order.

(c) You can customise the report created through Report

Wizard.

(d) The extension name given to report file is .FRX

2. How do you relate any two tables used in a report?

3. What is the difference between Print and Print Preview

commands?
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9.5 CREATING A REPORT WITH REPORT DESIGNER

Visual FoxPro provides a powerful tool to create new report through

Report Designer.  However, it is always convenient and good to create

a report through Report Wizard and then open it in Report Designer

for making any subsequent changes as per the requirement.

As you know that each report is based on a Database or a Table.

Therefore, in order to create a report, first you need to open a table

on which your report is based.  Choose Open… option from the File

menu and choose Table from the List Files of Type popup of Open

dialog box.  Select the existing table named STUDENT.DBF from the

File Name list and choose OK push button.

Now to create a new report by using the Report Designer, do the

following steps:

q Choose New… option from the File menu.

q In the New dialog box, choose Report radio button and then

choose New File push button.  A new report form appears in

the Report Layout window as shown in the figure 9.17

Fig. 9.17: Report Layout Window
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You can also create a new report form by typing:

CREATE    REPORT Press <RETURN> key in the command window.

A Report Layout Window appears with default title name.  You can

also type

CREATE    REPORT  <filename> Press <RETURN> key in the

command window to get a new report form named “filename.frx” in

the Report Layout.

Choose Quick Report… option from the Report menu to open the

Quick Report dialog box as shown in the figure 9.18.  Click the

Fields… push button from the Quick Report dialog box to open the

Field Picker dialog box as shown in the figure 9.19.

Fig. 9.18: The Quick Report Dialog Box

Fig. 9.19: The Field Picker Dialog Box
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Double click on the fields, which you want to be included in your

report.  For example double click on the following fields to move

them from All Fields list to Selected Fields list:

Enrol

Name

Fname

Course

Add1

Add2

Add3

Pin

Choose OK push button to return to the Quick Report dialog box,

again choose OK push button to return to the Report Designer

window as shown in the figure 9.20.

Fig. 9.20: The Report Designer Window

To create some workspace in your report form, click on the Page

Header band button and drag it down so that the Page Header area

looks like as shown in the figure 9.21.  Similarly you can create

some workspace by clicking on the Page Footer band button and

drag it down so that the Page Footer band area look like figure 9.21.
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Fig. 9.21: The Report Designer with Added Space

To move field headings in a Report Designer, select the field heading

and drag it to the require position.  To select several headings at

once, hold down the <Shift> Key while clicking on each field and

drag them to the required position.

To create a title in the Report Designer, you need to use the Report

Control Toolbar available in the View menu.  Click the label tool

and move the mouse pointer at the top of the Report Layout Window

and type “List of the Students”.  Choosing the Format menu, you

can align the title at the centre and increase the point size and

make it bold from the Font Style as per your requirement.

Now, choose Print Preview option from the File menu or click the

Print Preview tool to see how the report layout look like as shown

in the figure 9.22.

Fig. 9.22: The Print Preview Window with Title
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9.6 MODIFYING AN EXISTING REPORT

To modify an existing report form, do the following steps:

q Choose Open… option from the File menu.

q Select Report from the List Files of Type popup.

q Choose the report form file you want to open from the Open

dialog box.

You can also open an existing report through the command window

by typing:

MODIFY REPORT  <filename> Press <RETURN> Key

The report named “filename.frx appears in the Report Layout window

as it was previously saved.  Now, you can modify the report as per

your requirement in the same way as was discussed during previous

section of Creating Report with Report Designer.

9.7 PRINTING A REPORT

Before you print a report, you need to open the report in the MODIFY

REPORT <filename> mode.  After you open an existing report in

the Report Layout window, choose Print option from the File menu

or click the Print tool to display the Print Setup dialog box as shown

in the figure 9.23.

Fig. 9.23: The Print Setup Dialog Box

The options available with the Print Setup dialog box are self

explanatory, which allows you to select the Printer device, paper

orientation and the paper size.
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9.8 WHAT YOU HAVE LEARNT

In this lesson you have learned about two types of Report Wizards.

The first is general Report Wizard which formats a single table report.

The second is one-to-many Report Wizard which uses a parent-child

relation between two tables to create a report.  You have also learned

how to Group the report and to include the total of numeric fields

based on a grouping of records in the Report Wizard.  You have also

seen the limitations of the Report Wizard and beyond these limits

how to create a report by using Report Designer.

In the Report Designer you have learned about the basics of creating

a custom report, adding report controls to create a professional image

and title in your report.

9.9  TERMINAL QUESTIONS

1. Describe two types of reports available with Report Wizard?

2. Listout the various options available while saving a report.

3. Describe the one-to-many report format.

4. What are the steps for adding one more field ‘Income’ of numeric

width 7 in the report crested in figure 9.8.

5. Write steps for typing Title of the report when the report is

created using Report Designer.

6. What is the difference between Executive style and Presentation

style of reports.

9.10 KEY TO INTEXT QUESTIONS.

1. (a) T  (b) F  (c) T  (d) T

2. on the common field.

3. Print Preview command is used to view the data in advance on

the screen before final printing on the paper. The modifications

can be done, if the arrangement of data/text is not proper.

Print commands takes the final output on the printer and

provides a hard copy of it.


